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BAB III 

METODE PENELITIAN 

3.1  Desain Penelitian 

 Menurut Ma'ruf Abdullah dalam bukunya "Metodologi Penelitian" (2015), 

desain penelitian adalah suatu rencana yang disusun untuk memilih sumber-sumber 

daya dan data yang akan diolah guna memberikan jawaban terhadap pertanyaan-

pertanyaan penelitian. Desain penelitian dianggap sebagai cetak biru yang merinci 

cara data dikumpulkan, diukur, dan dianalisis, yang memungkinkan peneliti untuk 

mengevaluasi alokasi sumberdaya yang diperlukan. Maka dari itu peneliti 

menggunakan metode kuantitatif deskriptif dengan menggunakan survei, desain 

penelitian ini akan lebih fokus pada perencanaan langkah-langkah konkret terkait 

dengan pelaksanaan survei. Ini mencakup pemilihan sampel yang representatif, 

pengembangan kuesioner yang valid dan reliabel, serta strategi pelaksanaan survei 

yang efektif. Dengan menggunakan survei sebagai alat pengumpulan data, 

penelitian ini akan memastikan bahwa informasi yang diperoleh dari responden 

akan diukur secara kuantitatif, menghasilkan angka-angka yang dapat dianalisis 

untuk memberikan gambaran yang jelas dan terukur terhadap fenomena yang 

sedang diteliti. 

3.2  Jenis dan Metode Penelitian 

3.2.1 Jenis penelitian  

Menurut Nasution, penelitian deskriptif bertujuan memberikan 

gambaran tentang gejala, peristiwa, atau fenomena yang terjadi pada 

saat ini. Sugiyono (2013, hlm. 13) menunjukkan bahwa pendekatan 

kuantitatif digunakan untuk megukur variabel yang masih diteliti. 

Dalam metode penelitian deskriptif kuantitatif ini, penelitian bertujuan 

untuk menyajikan variabel penelitian dalam bentuk data aktual atau 

faktual, serta menyajikan hasilnya dalam bentuk angka yang bermakna. 
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3.2.2 Metode Penelitian 

 Penelitian ini menggunakan metode penelitian kuantitatif deskriptif, 

seperti yang dijelaskan oleh Prof. Dr. Sugiyono dalam bukunya tentang 

metode penelitian kualitatif, kuantitatif, dan R&D. Metode ini 

berlandaskan pada teori positivisme. Pendekatan ini digunakan untuk 

menjelaskan fenomena atau kejadian dengan asumsi bahwa realitas 

dapat diklasifikasikan sebagai sesuatu yang relatif, spesifik, teramati, 

teritorial, dan memiliki hubungan sebab akibat. Penelitian ini 

menggunakan metodologi penelitian kuantitatif untuk menguji dampak 

Total Quality Management (TQM) terhadap kepuasan karyawan dalam 

rangka perubahan lingkungan belajar di Binar Academy. Variabel 

independen dalam penelitian ini adalah implementasi TQM. Sementara 

variabel dependen adalah kepuasan peserta. Instrumen pengumpulan 

data berupa survei atau kuesioner telah dikembangkan untuk 

mendapatkan tanggapan dari peserta terkait aspek-aspek TQM dan 

tingkat kepuasan mereka. Pendekatan kuantitatif memungkinkan 

penelitian ini menyajikan data dalam bentuk angka-angka yang dapat 

diukur, sehingga memberikan gambaran yang lebih jelas dan terukur 

mengenai hubungan antara penerapan TQM dan kepuasan peserta di 

Binar Academy. 

3.2.3 Lokasi Penelitian 

 Penelitian ini dilakukan di Binar Academy, sebuah start up edu-tech 

yang menyediakan bootcamp online bagi peserta yang ingin 

mengembangkan keterampilan dalam bidang teknologi dan digital. 

Namun penelitian ini tidak terbatas pada lokasi fisik, partisipan dalam 

penelitian ini adalah peserta bootcamp online yang tersebar diberbagai 

lokasi geografis. 
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3.3    Populasi  

Populasi adalah cakupan wilayah berbasis generalisasi yang membandingkan 

suatu subjek atau objek dengan atribut khusus yang diidentifikasi oleh peneliti 

untuk dievaluasi dan kemudian diklasifikasikan. Efek dari pertumbuhan populasi 

tidak hanya memengaruhi individu tetapi juga aspek lain dalam kehidupan sehari-

hari, seperti pekerjaan dan lingkungan. Lebih tepatnya, populasi tidak hanya 

mewakili jumlah individu dalam suatu objek atau subjek yang dipelajari, tetapi juga 

mencakup semua karakteristik atau sifat yang dimilikinya. (Sugiyono, 2013 hlm. 

80). 

Tabel 3. 1 

Tabel Populasi Peserta 

 

Peserta Fresh Graduated Berstatus Alumni / Student Aktif 

yang Latar Belakang Pendidikan Non – IT 

Tahun Jumlah 

2023 (Juni-Desember)   37 

 

3.4     Sampel 

 Sampel adalah bagian dari jumlah anggota dan atribut populasi. Dalam 

situasi di mana peneliti memiliki keterbatasan waktu, uang, atau kendala lain dan 

populasi terlalu besar untuk dipahami sepenuhnya, mereka dapat menggunakan 

sampel untuk mewakili populasi. Pernyataan yang berlaku untuk seluruh populasi 

dapat dibuat dengan menggunakan data yang dikumpulkan dari analisis sampel ini. 

Oleh karena itu, sangat penting bahwa sampel yang dikumpulkan secara adil 

menangkap sifat-sifat total populasi. (Sugiyono, 2013 hlm. 81)   

 

 

 

 

 

Peserta Fresh Graduated Berstatus Alumni / Student Aktif 

yang Latar Belakang Pendidikan Non – IT dan masuk kriteria 

Tahun Jumlah 

Tabel 3. 2 

Tabel Populasi Peserta 
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3.5    Teknik Sampling 

 Dalam penelitian ini peneliti menggunakan  purposive sampling Nursalam 

dalam dalam buku Metodelogi Penelitian Pendekatan Multidisipliner (2020, hlm 

.195) Purposive sampling, juga dikenal sebagai judgement sampling, adalah 

metode pemilihan sampel di mana peneliti memilih sampel dari populasi 

berdasarkan tujuan atau kebutuhan penelitian. Dengan cara ini, sampel yang 

dipilih dimaksudkan untuk mencerminkan karakteristik yang telah diketahui 

sebelumnya dari populasi, sejalan dengan tujuan atau masalah penelitian  

3.6   Teknik Pengumpulan Data Penelitian 

Dalam setiap upaya penelitian, kualitas data dipengaruhi oleh dua faktor 

utama: kualitas alat penelitian dan prosedur pengumpulan data. Validitas dan 

reliabilitas instrumen penelitian terkait dengan kualitasnya, sedangkan akurasi 

teknik pengumpulan informasi terkait dengan kualitas prosedur pengumpulan 

data. Jika digunakan secara tidak jujur selama proses pengumpulan data, 

instrumen penelitian dengan validitas dan reliabilitas yang rendah tidak dapat 

memastikan hasil data yang valid dan dapat dipercaya. Sumber primer dan 

sumber sekunder adalah dua kategori pengumpulan data yang dapat dipisahkan 

berdasarkan sumbernya. Sumber primer datang dari pengumpul data secara 

langsung, sedangkan sumber sekunder datang dari pengumpul data melalui 

perantara, seperti orang lain atau dokumen. (Sugiyono,  2013 hlm. 7). 

  Salah satu cara untuk mengumpulkan data adalah melalui kuesioner, 

yang memungkinkan responden untuk memberikan jawaban tertulis atas 

pertanyaan yang diajukan untuk mendapatkan umpan balik. Kelebihan 

penggunaan kuesioner juga terlihat ketika jumlah responden cukup besar dan 

tersebar luas. Jenis pertanyaan dalam kuesioner bisa berupa tertutup atau 

terbuka, dan metode ini dapat diterapkan dengan memberikan kuesioner 

langsung kepada responden atau mengirimkannya melalui pos, internet, atau 

media lainnya, maka dari itu peneliti menggunakan angket dan dokumen dalam 

mengumpulkan data. 

2023 (Juni-Desember)   37 
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3.7  Instrumen Pengumpulan data  

  Penerapan teknik pengumpulan data lewat angket menurut 

Sugiyono dapat melibatkan penyusunan angket berbasis skala Likert. 

Angket yang dibuat akan mencakup item-item instrumen yang 

mengukur variabel penelitian dan menggunakan opsi jawaban sesuai 

dengan skala Likert. Sugiyono dalam buku Penelitian Kuantitatif 

Kualitatif dan R&D (2013, hlm. 93) dalam sebuah penelitian, skala 

Likert digunakan untuk menilai perspektif, keyakinan, dan persepsi 

individu atau kelompok tentang fenomena sosial tertentu. Peneliti telah 

menentukan fenomena sosial ini secara khusus, yang juga dikenal 

sebagai variabel penelitian. Skala Likert digunakan untuk mengubah 

variabel yang akan diukur menjadi variabel indikator. Setelah itu, 

indikator digunakan sebagai landasan untuk menetapkan item 

instrumen, yang dapat berupa pertanyaan atau pernyataan. Respon dari 

setiap item instrumen dapat berkisar dari sangat positif hingga sangat 

negatif. Skala ini dapat diartikulasikan dengan menggunakan kata-kata 

seperti: 

 a. Sangat Setuju  

 b. Setuju  

 c. Ragu-ragu 

  d. Tidak setuju  

 e. Sangat tidak setuju 

3.7.1 Kisi-Kisi Penelitian 

 Fenti Hikmawati dalam buku Metodologi Penelitian  (2020, hlm. 44) 

Peneliti harus memilih alat penelitian, teknik pengumpulan data, dan 

sumber data untuk penelitian mereka. Peneliti harus membuat “kisi-

kisi”, atau tabel dengan baris dan kolom yang menggambarkan 

hubungan antara berbagai elemen, untuk menyusun instrumen 
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penelitian. Tujuan dari kisi-kisi ini adalah untuk menggambarkan 

hubungan antara variabel yang diteliti dengan dimensi dan indikator 

berdasarkan variabel penelitian. 

Tabel 3. 3 

Kisi – kisi penelitian variabel X 

 

Total Quality Management (Variabel X) 

 

 

Variabel Indikator Sub Indikator Item 

Manajemen 

Mutu 

Terpadu, 

(Edward 

Deming, 

1950) 

Planning 1. Kejelasan tujuan dan 

sasaran bootcamp 

1,2 

2. Kualitas kurikulum 

dan Materi bootcamp 

3,4,5 

3.  Jadwal dan durasi 

bootcamp 

6,7 

Do 1.  Kemudahan Akses 

dan Penggunaan 

Teknologi 

8,9 

2. Efektivitas 

Penyampaian Materi 

Pelatihan 

10 

3. Aktivitas dan 

Partisipasi Peserta 

11,12 
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Tabel 3. 4 

Kisi – kisi penelitian variabel Y 

 

Kepuasan Pelanggan  (Variabel Y) 

 

Checking 1. Dukungan dan 

Bimbingan dari 

Fasilitator  

13, 14 

2.  Dukungan dari staff 

Binar 

 

15 

3. Format Evaluasi 16 

Act 1.  Keyakinan 

memberikan 

rekomendasi 

kepada orang 

lain  

17 

2. Dampak yang 

dirasakan terhadap 

perbaikan 

18, 19 

 3. Kesesuaian dengan 

harapan 

20 

Variabel Indikator Sub Indikator Item 

Kepuasan 

Pelanggan 

Kualitas Produk 1. Relevansi 

program terhadap 

1,2 
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(Meithiana 

Indrasari, 

2019) 

kebutuhan karier 

peserta 

2. Kepuasan 

terhadap kualitas 

materi 

pembelajaran 

3,4 

3. Kemudahan 

dalam mengakses 

materi 

pembelajaran 

5,6 

4. Kepuasan 

peserta terhadap 

fasilitator 

pembelajaran 

7,8,9 

Kualitas 

Pelayanan 

1. Kemampuan 

staf dalam 

memberikan 

layanan 

10 

2. Peserta merasa 

terjamin 

mendapatkan 

kompetensi yang 

dijanjikan 

11 

3.Sarana 

komunikasi yang 

diberikan antara 

peserta dengan 

pihak Binar 

Academy mudah 

di akses 

12 
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Aspek emosional 1. Kesediaan staf 

dalam 

memberikan 

empati terhadap 

keluhan yang 

diberikan 

13,14 

2. Memberikan 

dukungan 

psikologis kepada 

peserta terkait 

permasalahan 

pembelajaran 

15 

3. Peserta merasa 

lebih percaya diri 

dan bangga 

belajar di Binar 

Academy 

16 

 

 Harga 1. Peserta merasa 

harga yang 

dibayarkan sesuai 

dengan manfaat 

yang diterima 

17 

2. Keterjangkauan 

harga 

18,19 

 Biaya 1. peserta merasa 

terinformasi 

tentang biaya 

layanan tambahan 

yang disediakan 

20 
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3.8 Uji Coba Instrumen 

3.8.1 Uji Validitas 

Sugiyono dalam buku Penelitian Kuantitatif Kualitatif dan R&D (2013, hlm. 

121) Indikator yang valid mengacu pada alat yang digunakan untuk mendapatkan 

data yang valid (rnengukur). Validitas menunjukkan bahwa instrumen yang 

dimaksud dapat digunakan untuk menentukan apa yang perlu diubah. Valid artinya 

sejauh mana data mencerminkan kejadian sebenarnya pada obyek penelitian dan 

dapat diandalkan oleh peneliti. Oleh karena itu, data yang dianggap valid adalah 

data yang secara akurat mencerminkan keadaan yang sebenarnya pada obyek 

penelitian, tanpa adanya perbedaan yang signifikan antara laporan peneliti dan 

realitas yang terjadi.  

𝑟 =
𝑛(∑𝑥𝑦) − (∑𝑥)(∑𝑦)

√(𝑛∑𝑥2 − (∑𝑥)2)(𝑛∑𝑦2 − (∑𝑦)2)
 

r                 = Jumlah koefisien korelasi 

(Ʃxy)         = Jumlah perkalian X dan Y 

(Ʃx)           = Jumlah skor tiap butir 

(Ʃy)           = Jumlah skor total 

Ʃx2                = Jumlah skor-skor X yang dikuadratkan 

Ʃ 𝑌2               = Jumlah skor-skor Y yang dikuadratkan 

n              = Jumlah repsonden 

 

 Dengan membandingkan nilai R-kuadrat (Korelasi Product Moment Pearson) 

dengan tabel pada tingkat signifikansi 5% pada α = 0,05 dan panjang regresi (dk = 

n-2), dapat diketahui apakah data tersebut valid atau tidak valid. Kriteria berikut ini 

digunakan untuk memvalidasi setiap item: 

Jika r hitung lebih besar dari r tabel, maka pernyataan tersebut benar. 

Jika r hitung kurang dari r tabel, pernyataan tersebut tidak sah. 

Peneliti memberikan kuesioner kepada lima belas responden yang merupakan 

peserta Binar Academy untuk mengevaluasi instrumen. Temuan uji validitas 
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diperoleh untuk kedua variabel, yaitu Variabel X (Total Quality Management) dan 

Variabel Y (Kepuasan Peserta), berdasarkan hasil pengujian. 

Tabel 3. 5 

Hasil Perhitungan Uji Validitas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Variabel No. 

Item 

Koefisien 

Validitas 

(rhitung) 

Rtabel Kesimpulan Tindak Lanjut 

Kompetensi 

Digital (X) 

1 0,824 0,514 Valid Dipakai 

2 0,799 0,514 Valid Dipakai 

3 0,860 0,514 Valid Dipakai 

4 0,834 0,514 Valid Dipakai 

5 0,845 0,514 Valid Dipakai 

6 0,895 0,514 Valid Dipakai 

7 0,623 0,514 Valid Dipakai 

8 0,357 0,514 Tidak Valid Tidak Dipakai 

9 0,691 0,514 Valid Dipakai 

10 0,900 0,514 Valid Dipakai 

11 0,903 0,514 Valid Dipakai 

12 0,363 0,514 Tidak Valid Tidak Dipakai 

13 0,761 0,514 Valid Dipakai 

14 0,872 0,514 Valid Dipakai 

15 0,632 0,514 Valid Dipakai 

16 0,920 0,514 Valid Dipakai 

17 0,681 0,514 Valid Dipakai 

18 0,111 0,514 Tidak Valid Tidak Dipakai 

19 0,767 0,514 Valid Dipakai 

20 0,623 0,514 Valid Dipakai 

Efektivitas 

Kerja (Y) 

21 793 0,514 Valid Dipakai 

22 787 0,514 Valid Dipakai 

23 746 0,514 Valid Dipakai 

24 774 0,514 Valid Dipakai 

25 732 0,514 Valid Dipakai 

26 844 0,514 Valid Dipakai 

27 742 0,514 Valid Dipakai 

28 624 0,514 Valid Dipakai 

29 795 0,514 Valid Dipakai 

30 734 0,514 Valid Dipakai 
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 Berdasarkan tabel diatas, terlihat bahwa terdapat tiga item pertanyaan yang 

tidak valid pada variabel X dan satu pada variabel Y dengan item yang lainnya valid 

karena rhitungnya lebih besar dari 0,514 (Rtabel). Karena item pertanyaan yang 

tidak valid sudah terwakilkan dengan pertanyaan di satu indikator yang sama, maka 

pertanyaan tidak valid tersebut tidak dipakai sehingga pertanyaan yang akan 

peneliti gunakan untuk penelitian ini berjumlah 36 pertanyaan.  

 

3.8.2 Uji Reliabilitas 

Ma’ruf Abdullah dalam buku Metodologi Penelitian Kuantitatif (2015,  hlm. 

261) Ukuran keajegan alat ukur dalam menilai kejadian yang sama disebut 

reliabilitas. Diharapkan bahwa setiap alat ukur akan dapat menghasilkan temuan 

pengukuran yang dapat diandalkan untuk gejala yang sedang diukur. Winarno 

(2013, hlm. 111) Dalam konteks psikologi dan pendidikan, reliabilitas instrumen 

diinterpretasikan sebagai tingkat konsistensi dalam menghasilkan data. Oleh karena 

itu, sebuah instrumen memiliki peluang terbaik untuk berhasil jika sering dikoreksi 

secara ketat yang secara konsisten memberikan hasil atau skor yang berarti. 

Penilaian reliabilitas dilakukan dengan membandingkan koefisien Cronbach's 

Alpha dengan ambang batas signifikansi yang digunakan atau taraf. Jika koefisien 

reliabilitas lebih tinggi dari 0,60, di mana 0,60 adalah ambang batas signifikan atau 

ambang batas, maka suatu instrumen dianggap reliabel. 

Dalam penelitian ini peneliti mengunakan uji reliabilitas dengan rumus 

Cronbach’s Alpha. Sebagai berikut: 

𝑟11 =
𝑛

𝑛 − 1
(1 −

∑ 𝑆𝑖
2𝑛

𝑖−1

𝑆𝑡
2 ) 
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Keterangan: 

 

Hasil perhitungannya kemudian dibandingkan dengan distribusi t-tabel pada 

taraf signifikansi 0,05 dan derajat kebebasan (dk = n – 2). Suatu instrumen dianggap 

reliabel jika t-hitung lebih besar dari t-tabel. 

Dalam menghitung uji reliabilitas, peneliti menggunakan bantuan program 

SPSS versi 25.0 for Windows. Berikut adalah cara perhitungan uji reliabilitas data 

menggunakan metode Cronbach’s Alpha: 

1) Launch SPSS 25.0 application  

2) Extract the required data and then enter the data in the variable and data 

views.  

3) Select Analyze > Scale > Reliability Analysis from the menu.  

4) Next, a Reliability Analysis report will be issued. The data variable should be 

set to the item's scale (sebelah kanan) and the model's alpha.  

5) Select Statistics to display the Reliability Analysis: Statistics table. Next, select 

the Descriptive section to view the Original Scale and the Scale if the item is 

removed.  

6) Next, click on proceed.  

7) Click "OK" and view the data hitpointing result in the output. 

Tabel 3. 6 

Hasil Perhitungan Uji Realibilitas 

 

Variabel 
No. 

Item 

Cronbach 

Alpha if 

Item Deleted 

Cronbach 

Alpha 
Keterangan 

Kompetensi Digital (X) 

1 0,959 

0,962 Reliabel 2 0,960 

3 0,959 

 𝑟11  = koefisien reliabilitas 

 n = banyaknya butir soal 

 𝑆𝑖
2 = varians skor soal ke-i 

 𝑆𝑡
2 = varians skor total 
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4 0,959 

5 0,959 

6 0,958 

7 0,962 

8 0,962 

9 0,958 

10 0,958 

11 0,961 

12 0,959 

13 0,963 

14 0,958 

15 0,962 

16 0,961 

17 0,963 

Efektivitas Kerja (Y) 

18 0,954 

0,957 Reliabel 

19 0,954 

20 0,955 

21 0,954 

22 0,955 

23 0,953 

24 0,955 

25 0,956 

26 0,954 

27 0,955 

28 0,953 

29 0,954 

30 0,956 

31 0,955 

32 0,954 

33 0,955 
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34 0,955 

35 0,954 

36 0,956 

Berdasarkan tabel diatas, dapat dilihat bahwa nilai reliabilitas setiap itemnya 

memiliki nilai lebih dari 0,6. Artinya seluruh item yang valid dalam penelitian ini 

memiliki nilai yg reliabel.  

 

 

3.9  Prosedur penelitian 

 Mengacu pada pedoman Karya Tulis Ilmiah UPI 2021 Prosedur penelitian 

Menjelaskan secara berurutan bagaimana desain penelitian diaplikasikan secara 

konkret, terutama dalam merinci langkah-langkah penelitian yang dilakukan. 

Berdasarkan hal tersebut peneliti melakukan :  

1. Peneliti melakukan studi pendahuluan terlebih dahulu untuk memperoleh 

pemahaman mendalam tentang implementasi Total Quality Management 

(TQM) di Binar Academy dan dampak nya kepada peserta kegiatan. 

2. Peneliti menetapkan variabel penelitian, termasuk elemen TQM yang 

relevan dengan perubahan karier dan kepuasan peserta di Binar Academy. 

3. Peneliti merumuskan masalah penelitian yang mencakup sejauh mana 

TQM berpengaruh terhadap perubahan karier lulusan dan kepuasan 

peserta di Binar rumusan masalah sebagai fokus penelitian. 

4. Peneliti menyusun hipotesis penelitian yang mencerminkan hubungan 

positif antara penerapan TQM dengan perubahan karier dan kepuasan 

peserta. 

5. Peneliti memilih metode kuantitatif sebagai pendekatan untuk mengukur 

variabel dan pengaruh TQM terhadap perubahan karier dan kepuasan 

peserta serta  menggunakan pendekatan survei dan analisis statistik dalam 

pengumpulan dan analisis data. 

6. Peneliti merancang kisi-kisi instrumen berupa kuesioner dengan 

pertanyaan terkait variabel TQM, perubahan karier, dan kepuasan peserta 
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lalu melakukan uji validitas dan reliabilitas untuk memastikan keakuratan 

instrumen. 

7. Menyebar kuesioner peserta program di Binar Academy untuk 

mengumpulkan data mengenai penerapan TQM dan kepuasan peserta. 

8. Mengolah data dengan teknik statistik seperti analisis regresi untuk 

menguji hubungan antara variabel TQM, perubahan karier, dan kepuasan 

peserta serta  menyajikan hasil analisis melalui grafik dan tabel yang jelas. 

9. Membahas temuan hasil analisis data secara mendalam, menghubungkan 

dengan teori TQM, dan memberikan interpretasi implikasi terhadap 

perubahan karier dan kepuasan peserta. 

10. Merumuskan kesimpulan berdasarkan temuan penelitian dan menyajikan 

implikasi hasil penelitian terhadap implementasi TQM di Binar Academy 

dan memberikan rekomendasi untuk perbaikan lebih lanjut. 

11. Menyusun laporan penelitian yang mencakup semua langkah penelitian, 

temuan, dan rekomendasi lalu menyajikan hasil secara sistematis 

mengikuti struktur penulisan ilmiah yang sesuai. 

3.10  Analisis Data 

        Sugiyono (2013, hlm. 147) menyatakan dalam bukunya “Metodologi 

Penelitian Kuantitatif Kualitatif dan R&D,” bahwa salah satu elemen yang paling 

penting dalam mencapai tujuan penelitian kuantitatif adalah analisis data. Teknik 

statistik digunakan dalam penelitian kuantitatif untuk menganalisis data. Statistik 

deskriptif dan inferensial adalah dua bentuk statistik yang sering digunakan dalam 

analisis data. Ketika menganalisis data, statistik deskriptif digunakan untuk 

memberikan deskripsi atau contoh yang tepat dari data yang telah dikumpulkan, 

tanpa mencoba menghasilkan hasil rata-rata atau generalisasi. Peneliti dapat 

menggunakan statistik deskriptif jika mereka ingin menjelaskan data sampel 

semata-mata dan tidak ingin membuat asumsi tentang populasi tempat sampel 

dikumpulkan. Perlu dicatat bahwa analisis regresi yang signifikan, analisis regresi, 

atau perbandingan rata-rata atau lebih besar antara keduanya tidak diperlukan 

dalam kasus ini. 

3.10.1 Seleksi Data 
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 Pada tahap ini, data dari responden diperiksa untuk memastikan bahwa 

mereka memenuhi syarat-syarat yang diperlukan untuk diproses pada tahap analisis 

berikutnya. Langkah-langkah yang dilakukan mencakup: 

a.  Memverifikasi bahwa jumlah kuesioner yang diberikan dan jumlah yang telah 

terkumpul telah sesuai. 

b. Setelah jumlah kuesioner yang terkumpul sesuai, peneliti memverifikasi 

bahwa responden telah mengisi semua item pernyataan dan proses pengisian 

kuesioner telah diikuti.  

c. Data yang memenuhi persyaratan diperiksa sebelum peneliti memprosesnya 

sesuai dengan kebutuhan studi. 

3.10.2 Klasifikasi Data  

Dalam proses ini, data dikelompokkan berdasarkan variabel penelitian 

dengan memberikan skor pada setiap item pertanyaan sesuai dengan kriteria skor 

yang telah ditetapkan, terutama ketika menggunakan skala Likert. Klasifikasi data 

membantu menyusun struktur data yang terorganisir, memberikan dasar untuk 

analisis lebih lanjut, dan menghasilkan skor mentah variabel sebagai sumber data 

yang akan diolah pada tahap berikutnya. 

3.11   Pengolahan Data 

 Pengolahan data adalah tahap terakhir dari analisis data. Untuk menjawab 

masalah penelitian, berbagai teknik statistik digunakan dalam prosedur ini. 

Pengolahan data membantu menggambarkan pola atau tren yang dapat 

diidentifikasi dari data mentah, menyediakan dasar untuk interpretasi yang 

mendalam, dan mendukung pembentukan kesimpulan yang lebih tepat. 

3.11.1 Menghitung Kecenderungan Umum Skor Responden 

Berdasarkan Perhitungan Rata-Rata WMS (Weight Means Score) 

Skor mentah dihitung dengan menggunakan pendekatan Weighted Means 

Score (WMS) untuk memastikan tren keseluruhan dari jawaban setiap variabel 

setelah data diklasifikasikan dan skor pertama dari jawaban responden terhadap 

variabel-variabel penelitian diperoleh. Teknik ini memberikan gambaran rata-

rata yang signifikan terkait respons responden,  
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Adapun rumus Weight Means Score (WMS), sebagai berikut : 

𝑥 ̅ =
∑𝑋

𝑛
 

Keterangan :  

 

 

Langkah – langkah dalam mengelola WMS yaitu :  

1. Atribusi nilai bobot pada setiap opsi jawaban menggunakan skala Likert 

yang berkisar antara 1 hingga 5. 

2. Perhitungan total responden untuk setiap item dan kategori jawaban. 

3. Penyajian jawaban responden untuk setiap item, yang secara langsung 

terhubung dengan bobot opsi jawaban yang digunakan. 

4. Penghitungan nilai rata-rata untuk setiap item dalam setiap kolom. 

5. Penetapan kriteria untuk mengelompokkan hasil WMS berdasarkan nilai 

rata-rata dari setiap kemungkinan jawaban. 

6. Penyesuaian hasil perhitungan variabel dengan kriteria yang telah 

ditetapkan untuk mengidentifikasi kecenderungan masing-masing variabel. 

Tabel 3. 7 

Tabel konsultasi WMS 

 

   Peneliti menggunakan perhitungan WMS dari tabel di atas untuk 

menilai perhitungan instrumen untuk setiap variabel dengan menggunakan 

𝑥        =  Nilai rata – rata yang dicari 

∑𝑋   =  Jumlah skor gabungan )frekuensi jawaban dikali bobot nilai untuk  

 setiap alternatif jawaban) 

n       = Jumlah Responden 

Rentang Nilai Kriteria Penafsiran 

Varibel X Variabel Y 

4,01 – 5,00 Sangat Setuju Sangat Baik Sangat Baik 

3,01 – 4,00 Setuju Baik Baik 

2,01 – 3,00 Cukup Setuju Cukup Baik Cukup Baik 

1,01 – 2,00 Kurang Setuju Kurang Baik Kurang Baik 

0,01 – 1,00 Tidak Setuju Tidak Baik Tidak Baik 

   



46 
 

MUHAMAD RAYHAN RAMADHAN, 2024 
PENGARUH TOTAL QUALITY MANAGEMENT TERHADAP KEPUASAN PESERTA DALAM 
PERUBAHAN KARIER LULUSAN DI BINAR ACADEMY 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

 
  

skala Likert. Kriteria memiliki nilai mulai dari 4,01 - 5,00 (Sangat Baik) 

hingga 0,01 - 1,00 (Sangat Rendah). 

 

3.11.2 Mengubah Skor Mentah Menjadi Skor Baku 

T – Score digunakan untuk melihat perbedaan signifikan rata-rata suatu 

populasi sampel dengan rata-rata populasi yang lebih besar dalam Himawati 

(2020, hlm.117). Rumus yang digunakan untuk melakukan transformasi skor 

mentah menjadi skor baku adalah sebagai berikut: 

𝑇𝑖 = 50 + 10 
(𝑋𝑖 − 𝑥 )

𝑆𝐷
 

Keterangan :  

 

Mengubah skor mentah menjadi skor baku melalui penggunaan perangkat lunak 

SPSS versi 25.0 untuk Windows dapat dilaksanakan dengan mengikuti 

serangkaian langkah sebagai berikut: 

1. Start by opening SPSS version 25.0 and move the X and Y dependent 

variable data scores to the data view tab. 

2. Begin with data analysis, followed by descriptive statistics, and end with 

descriptive selections. 

3. Enter the X and Y variables to adjust the z value. 

4. Click OK after the checkbox to save the standardization value as a variable. 

5. The z value of each variable will be visible on the data view tab. Select the 

variable view tab and change the name of the Z value to, for example, Z 

score. 

6. Next, select Transform from the menu, then select Compute. 

7. Enter the target variable in the box provided on the top left, such as Raw_X. 

Ti  = Skor Baku 

Xi  = Skor Mentah Untuk Masing – Masing Responden 

𝑥   = Rata – rata (Mean) 

SD  = Standar Deviasi 
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 8.  In the numeric expression column, type T = 50 + (10 * z score) (click the 

 Z Score variable twice to insert it into the numeric expression column), then 

 click OK. 

9.  The t score results of each variable (raw data) will appear in the data view 

tab. 

3.12 Pengujian Prasyaratan Analisis 

3.12.1 Uji Normalitas 

   Ma’ruf Abdullah (2015, hlm. 322) Tujuan dari uji normalitas adalah 

untuk mengetahui apakah data yang digunakan dalam penelitian memiliki 

distribusi normal, baik dari segi analisis multivariat maupun univariat. 

Analisis Satu Sampel Kolmogorov-Smirnov digunakan untuk 

membandingkan distribusi teoritis yang diharapkan dengan distribusi 

fungsional dari suatu variabel. Berikut langkah – langkah nya :  

1. Launch the IBM SPSS Statistics 25 Windows application. 

2. Enter the missing data for each variable, namely variables X and Y, on the 

data view tab. 

3. The Variable View Pilih Tab. The first bar in the column "name" is labeled 

with the variable name X, while the second bar is labeled with the variable 

name Y. The value of the "decimal" column is set to 0, and each variable's 

name is entered in the "label" column. 

4. Return to the data view tab, select Analyze, then choose Regression and 

Linear to convert the data to residuals. In the linear regression dialog box, 

set variable X to independent and variable Y to dependent. Click the "Save" 

option, select "Unstandardized" from the residual table, then click 

"Continue" and "OK." 

5. Automatically, a new variable called the unstandardized residual will 

appear in the tab data view. 

6. Next, select menu analyze, select nonparametic test, and then select 1-

Sample K-S in legacy dialogs. 

7. In the test variable list, place variables X, Y, and unstandardized residual 

after selecting a choice and then clicking the OK button to proceed with the 
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mind mapping.Pilih exact, pada kotak exact tests, beri centang pada pilihan 

Monte Carlo, kemudian continue, lalu OK. 

 

3.12 Uji Hipotesis Penelitian 

3.12.1 Analisis Koefisien Korelasi 

 Morrisan (2015, hlm. 386) dalam buku Metode Penelitian Survei Korelasi 

Pearson product-moment digunakan untuk menilai tingkat hubungan antara dua 

variabel, sering dilambangkan dengan huruf "r". Berikut rumus nya :  

 

𝑟 =  
𝑁∑𝑋𝑌 − ∑𝑋∑𝑌 

√[𝑁∑𝑋2 − (∑𝑋)2][𝑁 ∑𝑋2 − (∑𝑋)2]
 

Keterangan :  

 

Tabel 3. 8 

Kriteria Interpretasi Koefisien Korelasi (Sugiyono, 2015 hlm. 242) 

 

Interval 

Koefisien  

Tingkat 

Hubungan  

0,00 – 0,199  Sangat Rendah  

0,20 – 0,399  Rendah  

0,40 – 0,599  Sedang  

0,60 – 0,799  Kuat  

0,80 – 1,00  Sangat Kuat  

 

R = Koefisien korelasi yang dicari 

X = Data item Soal 

Y = Data jumlah item soal 

∑𝑋 = Jumlah skor item soal 

∑𝑌 = Jumlah skor hasil jumlah item soal 

ΣXY    = Total perkalian antara X dan Y 

 ∑𝑋2   = Nilai X yang dikuadratkan 

N = Jumlah responden 
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Langkah-langkah dalam menganalisis Koefisien Korelasi menggunakan SPSS 

25.0 for Windows adalah sebagai berikut: 

1. Start by opening the SPSS 25.0 for Windows application and select the Type 

In Data option. 

a. Name column for row X and the second row is filled with Y;  

b. Type column is filled with Numeric;  

c. Width column is filled with 8;  

d. Decimal column is filled with 0;  

e. Label column for the first row is filled with Variable X name and the 

second row is filled with Variable Y;  

f. Value and Missing columns are filled with 0. The Value and Missing 

columns are filled with 0. The Value and Missing columns are filled with 

None;  

g. Columns column is filled with 8;  

h. Align column select Center.  

i. Measure column select Scale;  

2. Enter data in the Data View column for variables X and Y.Beralih ke 

Variable View, ubah nama di kolom Name menjadi Variabel X untuk baris 

pertama dan Variabel Y untuk baris kedua. Selanjutnya, atur kolom 

Decimals menjadi 0, dan kolom Label diisi dengan nama masing-masing 

variabel. Untuk kolom Measure, pilih Nominal, dan abaikan kolom lainnya. 

3.    Select the Analyze option from the main SPSS menu, then click Correlate 

 and Bivariate. 

4.    A Bivariate Correlations dialog box will appear. After calculating variables   

 X and Y, use a panah tanda to move the data to the Variables table. 

5.   For the Correlations Coefficients test, use the Pearson test, and for the Test 

 of Significance, use the One-Tailed test. 

6.  Click on the Options tab, then select the Means and Standard Deviations   

option. Finally, click OK and continue. The results of the survey will be 

displayed through the Correlations Table. 
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3.12.2 Uji Signifikasi Koefisien Korelasi 

 Morrisan(2015, hlm. 349) dalam buku Metode Penelitian Survei Uji t 

digunakan untuk mengevaluasi perbedaan signifikan antara nilai rata-rata, 

dan juga untuk menguji apakah korelasi memiliki perbedaan yang signifikan 

dari nol. Selain itu, uji t membantu menentukan apakah nilai korelasi tersebut 

lebih dari sekadar kebetulan. Berikut rumus nya :  

𝑡 =  
𝑟√𝑛 − 2

√1 − 𝑟2
 

Keterangan :  

 

Berikut adalah langkah-langkah untuk melakukan analisis regresi linear 

menggunakan aplikasi program SPSS 25.0 for Windows: 

1. Launch the SPSS 25.0 for Windows application and enter the data for 

variables X and Y in the Data View tab. 

a. The first column name is written as X, and the second column is written 

as Y;  

b. The type of column is written as Numeric;  

c. The width is written as 8;  

d. The decimal column is written as 0;  

e. The label for the first column is written as Variable X, and the second 

column is written as Variable Y;  

f. The value and missing column is written as None;  

g. The columns are written as 8;  

h. column Align select Center.  

i. Kolom Measure select Scale;  

 

 

t = Nilai thitung  

r = koefisien korelasi hasil rhitung  

n = Jumlah responden 
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2. Select the variables X and Y in the first column for the first and second bars 

in the Variable View tab. Labels are labeled with the names of the individual 

variables.Klik menu Analyze, lalu pilih Regression dan Linear. 

3. The Linear Regression dialog box will appear. For variable X, select 

Independent(s) and for variable Y, select Dependent. 

4. Select Statistics, then click Continue after making adjustments to the 

Estimates, Model Fit, and Descriptive options. 

5. Choose Plots: A Linear Regression Plot dialog box with several selection 

options will appear. Click Next after selecting SDRESID and moving to the 

Y box and ZPRED and moving to the X box. 

6. In Scatter 2 of 2, place ZPRED and DEPENDENT in the Y and X boxes. 

Press and hold the Histogram and Normal Probability Plot buttons, then 

select Continue. 

7.  Select Save, then click the Unstandardized option in the Predicted Values 

column. Click the Mean and Individual options in the Prediction Intervals 

column, then select Continue. 

8. Select OK. The calculation results will be displayed using the Coefficient 

Table. 

 

3.12.3 Uji Koefisien Determinasi 

  Morrisan (2015, hlm. 388) Koefisien determinasi adalah bagian dari total 

(keseluruhan) variasi dari satu pengukuran yang dapat ditentukan oleh 

pengukur lainnya. Berikut rumus nya :  

𝐾𝐷 = (𝑟2) 𝑥 100% 

Keterangan :  

KD = Koefisien Determinasi  

𝑟2 = Koefisien Korelasi 

  Berikut adalah langkah-langkah untuk menghitung koefisien determinasi 

menggunakan SPSS Ver. 25.0 for Windows: 

1. Launch the SPSS 25.0 Windows application. 

2. Select Data View and enter the values for Variables X and Y. 
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3. Select Analyze, then Regression, and finally Linear. 

4. Assign variable X to the independent variable and variable Y to the 

dependent variable. 

5. Select Statistics, then click Proceed after making changes to Estimates, 

Model Fit R Square, and Descriptive. 

6. Select Plots, insert SDRESID into Y and ZPRED into X, and then select 

Next.Masukkan ZPRED ke kotak Y dan dependent ke kotak X. 

7. Select the Normal Probability and Histogram, then click Proceed.  

8. Select Save under Predicted Value, then Unstandardized and Prediction 

Intervals. Next, select Mean and Individual, and finally select Proceed.  

9. Click Options, confirm that the probability estimate is less than 0.5, and 

then click Proceed.  

10. Press the OK button. 

 

3.12.4 Uji Linearitas 

 Untuk menentukan apakah dua variabel memiliki hubungan linear atau 

tidak, lakukan uji linearitas. Sebelum melakukan analisis regresi linier atau 

korelasi Pearson, prosedur ini merupakan prasyarat yang penting. Dua variabel 

dianggap memiliki hubungan yang linear ketika signifikansi (linearity) kurang 

dari 0,05 ketika menggunakan SPSS untuk menjalankan Test for Linearity 

dengan tingkat signifikansi 0,05. (Rochmat Aldy 2016, hlm. 94). Berikut 

langkah langkah nya : 

1.  Launch the Statistical Product for Service Solutions application (SPSS). 

2.  Enter the text data in the Data View field. 

3. After entering all the data, select the Analyze menu, then select Compare 

Means and click Means. 

4. A dialog box appears; next, the dependent list's variable Y and the 

independent list's variable X are shown. Click on Options. 

5. Create a new dialog box when the Opsi Test for Linearity appears. Click 

Proceed, then click OK. 
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6. The research results will be presented, with special attention paid to the 

ANOVA table. 

 

3.12.5 Analisis Regresi Linear Sederhana 

Analisis regresi digunakan untuk meramalkan sejauh mana nilai variabel 

dependen akan berubah ketika nilai variabel independen mengalami perubahan. 

Sementara korelasi dan regresi memiliki keterkaitan yang erat Berikut rumus nya :  

𝑌̂ = 𝑎 + 𝑏𝑋 

Keterangan :  

Keterangan :  

 

 

Berikut adalah langkah-langkah untuk melakukan analisis regresi menggunakan 

program SPSS versi 25.0 for Windows: 

1. Launch the SPSS 25.0 Windows application. 

2. Select Data View and add data for Variables X and Y to each column of X 

and Y individually. 

3. Select Analyze from the menu, then Regression and finally Linear. 

4. Assign the Variable Total Quality Management (X) to the Independent and 

the Variable Workload (Y) to the Dependent. 

5. Select Descriptive, Model Fit R Square, Estimates, and Statistic, then click 

Proceed. 

6. Select Plots, insert SDRESID into Y and ZPRED into X, and then select 

Next. 

7. Attach ZPRED and DEPENDENT to the Y and X kotaks. 

8. Select the Normal Probability Plot and Histogram, then click Proceed. 

 

𝑌̂ = Nilai yang diprediksikan  

A = Konstanta atau bila harga X = 0  

B = Koefisien Regresi  

X = Nilai variabel independen 
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9. Select Predicted Value, then Unstandardized and Prediction Intervals. 

Then, note the Mean and Individu, and click Proceed. 

10. Click Options, confirm that the Probability estimate in the Default 

condition is 0.05, and then click Proceed. After that, click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 


